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Dalam era teknologi komputer dewasa ini, ada satu aspek yang sering dilupakan oleh para 
penulis buku dan karya ilmiah, akademik, atau profesional yaitu aspek tipografis. Aspek 
ini sangat erat kaitannya dengan masalah keterbacaan (readibility) cetakan karya terse-
but. Keterbacaan yang dimaksud di sini adalah tingkat kenyamanan visual cetakan 
sehingga pembaca cukup tahan lama membaca karena mata tidak mengalami kelelahan 
(fatigue). Keterbacaan cetakan ditentukan oleh format, susunan, jenis huruf, dan tata 
wajah cetakan. Misalnya, dalam hal pemilihan format rata kanan atau tidak, Moore (1995) 
menunjukkan aspek yang harus dipertimbangkan yaitu (lihat uraian dalam lampiran):

• Readability
• Suitability
• Producibility
• Line width
• Space

Usulan penelitian dapat ditolak bukan karena isinya tetapi karena penyajiannya yang 
tidak nyaman dibaca. Lebih dari itu, pemilihan tipa atau jenis huruf (typeface) dapat mem-
buahkan hasil yang berbeda sebagaimana dikatakan oleh Will-Harris (1994) berikut ini:

“The right typeface can encourage people to read your message. The wrong typeface 
or bad typography can make your message go unread.”

“Type is image. If you were going to an important meeting, you’d dress your best. 
Your documents need to be well-dressed too. Type can reinforce (or diminish) your 
image as a company or individual.”

Plumley (1992) meyakinkan arti pentingnya penampilan tipografis suatu dokumen 
cetakan dengan mengatakan:

“The main purpose of printed material, for example, is to convey a message to the 
reader. Likewise, the main purpose of design is to convey a message that attracts 
your readers’ attention and persuade them to pick up the printed material and read 
it, creating readers rather than browsers.”

Dalam memberi petunjuk penulisan surat, Griffin (1996) membahas bagaimana cara 
agar surat berpenampilan bagus (How to look very good on paper). Di dalamnya, Griffin 
menguraikan pesan yang disampaikan oleh kertas warna. Beberapa buku teks (khususnya 

1Kata business penulis usulkan untuk diserap menjadi busines bukan bisnis untuk menaati pedoman 
pembentukan istilah dan untuk kepentingan masa datang dan mencapai keintelektualan bahasa Indonesia.
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terbitan Indonesia) sering tidak menarik untuk dibaca bukan karena isinya tetapi karena 
aspek tipografis tidak diperhatikan dalam merancang buku atau tulisan akademik 
sehingga pembaca merasa cepat lelah untuk membacanya. Dalam akuntansi dikenal kon-
sep substance over form. Konsep ini sebenarnya hanya berlaku dalam kondisi darurat. 
Dalam kondisi normal, substansi dan bentuk penyajian (format) keduanya penting. Ibarat 
makanan, dokumen cetakan yang sehat (isinya berbobot) saja tidak cukup tetapi dokumen 
cetakan juga harus lezat (palatable) untuk dibaca.

Teknologi menulis (komputer, program pengolah kata, dan perangkat lunak pen-
dukung lainnya) telah memungkinkan penulis buku ajar merancang penampilan buku-
nya. Pekerjaan yang dulu dikerjakan oleh percetakan sekarang dapat dikuasai atau 
dikendalikan oleh penulis sehingga penulis dapat mengekspresi rasa seninya dalam 
tulisannya. Oleh karena itu, penulis juga harus mempunyai pengetahuan dasar tentang 
tata wajah (typesetting). Kenyataan bahwa kita telah menggunakan komputer tidak 
berarti bahwa kita telah menggunakan secara optimal sebagaimana mestinya. Sering ter-
jadi, orang menggunakan komputer tetapi masih berpikir seperti orang menggunakan 
mesin ketik.

Pengertian Tipografi
Tipografi adalah pengetahuan dan seni tentang pendesignaan (pendesainan) atau pemfor-
matan dokumen cetakan. Pengetahuan ini membahas bagaimana elemen tipografis dipilih 
dan digunakan dalam merancang hasil cetakan suatu dokumen. Plumley (1992) menjelas-
kan pengertian tipografi sebagai berikut:

“Typography, one of the most important elements of design, refers to the style, 
arrangement, or appearance of typeset elements and the general appearance of 
printed page.”

Typografi membahas format/gaya, susunan, penampilan elemen-elemen tata wajah 
dan berkaitan dengan penampilan umum suatu wajah cetakan. Tipografi membantu 
meningkatkan keterbacaan suatu dokumen karena keterbacaan merupakan alasan utama 
untuk merancang tampilan dokumen sebaik-baiknya. Rancangan yang tidak cermat yang 
dimaksudkan untuk mengiluminasi bacaan salah-salah malah dapat mendistraksi suatu 
pesan yang akan disampaikan. Arti penting tipografi dalam merancang penampilan doku-
men cetakan ditunjukkan oleh Hadfield (1994) sebagai berikut (penebalan oleh penulis):

“These days, to be accepted socially, you need to be ‘politically correct.’  The business 
world is no different: to be accepted professionally, you need to be typographically 
correct.”

Dunia akademik/profesional tentunya dapat mengambil hikmah dari pernyataan 
tersebut. Untuk dapat diterima atau dihormati secara akademik, akademisi harus benar 
secara tipografis. Tipografi sebenarnya juga meliputi aspek kebahasaan khususnya yang 
berkaitan dengan tanda baca (punctuation) dan pengejaan (spelling).

Lebih jauh, aspek tipografis tidak hanya penting untuk memenuhi kualitas keterba-
caan oleh manusia tetapi juga oleh mesin baca. Dalam salah satu halaman buku petunjuk 
telepon di Amerika, acapkali dimuat informasi tentang cara-cara pengalamatan. Untuk 
mendorong ketaatan terhadap cara penulisan alamat tersebut, Kantor Pos di Amerika 
(US Postal Service) menawarkan potongan bea kirim kepada perusahaan yang mencan-
tumkan tambahan angka empat digit setelah koda pos lima digit (ZIP code) pada alamat 
surat yang dikirimkannya. 
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Teknologi Menulis
Aspek tipografis menjadi sangat penting dewasa ini karena teknologi komputer sudah 
begitu canggihnya sebagai alat bantu untuk menulis. Generasi muda sekarang banyak 
yang tidak mengenal lagi mesin ketik. Komputer personal mulai menjadi perlengkapan 
standar rumah tangga mengganti mesin ketik. Perkembangan perangkat keras teknologi 
komputer juga dibarengi dengan perkembangan yang pesat dalam perangkat lunak. Pro-
gram pengolah kata (word processing) yang semula berdiri sendiri sekarang telah diinte-
grasi dengan speller, grammatical check, graphics, spreadsheed, dan thesaurus sehingga 
tidak ada batas lagi antara word processing dan desk top publishing (DTP). Pemindai 
(scanner) dan pembaca karakter optis (optical characters reader) juga menjadi bagian inte-
gral alat tulis kantor. Dengan kemajuan tersebut, penulis buku atau karya ilmiah/profe-
sional lain sekarang sebenarnya mempunyai kekuasaan dan keleluasaan untuk 
menentukan sendiri rancangan tipografis karyanya yang dulunya dikerjakan tim 
tipografer profesional yang disediakan oleh percetakan. 

Dengan tersedianya teknologi semacam itu, konsep atau paradigma berpikir dalam 
menggunakan komputer harus berbeda dengan konsep berpikir dalam menggunakan 
mesin ketik. Artinya, harus dibedakan antara typing dan word-processing. Dengan 
teknologi komputer, harus ditinggalkan kebiasaan-kebiasaan menulis yang melekat pada 
penggunaan mesin ketik. Dalam praktiknya, masih banyak orang yang melupakan 
masalah ini yaitu menggunakan word processor tetapi masih berpikir seperti meng-
gunakan mesin ketik. Keadaan ini mendorong Williams (1992) untuk menulis buku ber-
judul The PC Is Not A Typewriter. Karena komputer bukan mesin ketik, kita harus 
meninggalkan berbagai kebiasaan atau warisan yang melekat pada penggunaan mesin 
ketik. Hadfield (1994) menggambarkan ironi ini dengan mengatakan: 

“In the digital age, it’s easy to assume that just because we have the tools to produce 
typeset-quality document, we automatically know how to do so. We don’t.”

Walaupun istilah mengetik (typing) masih digunakan sampai sekarang dan nanti, isti-
lah ini sekarang harus dimaknai sebagai menata wajah (typesetting). Dengan teknologi 
komputer dan program pengolah kata yang canggih, kekuasaan menata wajah sekarang 
ada di tangan penulis.

Beberapa dokumen cetakan yang kita baca tiap hari acapkali sangat lezat di mata 
tanpa kita menyadarinya. Sebenarnya, terdapat pengetahuan atau ilmu di balik tampilan-
tampilan dokumen cetakan menawan tersebut. Dalam banyak hal, kita dapat meniru 
tampilan tersebut tanpa kita mengetahui prinsip atau kaidah yang digunakan. Pende-
katan seperti itu sah-sah saja tetapi sebenarnya cara demikian sama saja dengan cara 
memperoleh pengetahuan secara alamiah (sering disebut cara MSMD = monkey see, mon-
key do). Cara terbaik untuk menghasilkan dokumen yang sama adalah mempelajari prin-
sip-prinsip yang ada di balik penampilan dokumen dengan kesadaran dan penalaran 
(belajar secara ilmiah atau lebih tepatnya secara terpelajar). Dengan pengetahuan itu, 
kita akan menjadi lebih kreatif dalam merancang dokumen cetakan dengan tetap berpe-
gang pada prinsip tipografis. Oleh karena itu, kita perlu mengenal elemen-elemen designa 
tipografis. Beberapa lampiran di akhir makalah ini menyajikan contoh hasil cetakan yang 
kurang memenuhi kaidah tipografis.

Elemen Designa Tipografis
Untuk dapat merancang dokumen cetakan yang secara tipografis benar, perlu dipahami 
beberapa elemen berikut ini:
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• Typefaces/fonts (type styles)
• Spacing (letter/word/line/paragraph)
• Paragraph style (style sheet)
• Kerning
• Text alignment
• Indentation/Tabs
• Pagination (size/orientation)
• Illustrations and tables (use of line types)
• Headings, subheadings, and captions
• Emphasis (attributes)
• Typographic characters

Beberapa elemen penting dibahas di bawah ini.

Typefaces/Fonts
Pada mulanya istilah fon (font) digunakan untuk menunjuk atribut huruf yaitu: biasa 
(plain), tebal (bold), dan miring (italic) sedangkan istilah typeface digunakan untuk 
menunjuk jenis huruf seperti: Times New Romance, Arial, Courier, dan Century School-
book. Dalam perkembangannya, keduanya digunakan secara bergantian untuk menunjuk 
jenis huruf.

Secara tipografis, fon diklasifikasi atas dasar karakter menjadi proporsional dan non-
proporsional/monospasi (monospace). Untuk fon proporsional, tiap karakter menempati 
lebar atau spasi proportional dengan huruf abjad bersangkutan. Misalnya, huruf “W” 
akan menempati spasi yang lebih lebar dibanding huruf “i” seperti pada fon Times New 
Roman. Berikut adalah contoh tampilan huruf proporsional tersebut.

Ini adalah contoh tulisan dengan huruf proporsional. Salah satu contoh adalah huruf 
Times New Roman. Pengolah kata Word dari Microsoft distel dari pabrik (default 
setting) dalam huruf proportional. WWWWWWWW iiiiiiii pppppppp.

Untuk fon nonproporsional, tiap karakter menempati spasi yang sama untuk semua 
huruf abjad bersangkutan. Misalnya, huruf “W” akan menempati spasi yang sama dengan 
huruf “i” seperti pada fon Courier. Berikut contoh tampilan fon ini.

Ini adalah contoh tulisan dengan huruf nonproporsional 
yaitu Courier. Pengolah kata Word dari Microsoft tidak 
distel dari pabrik (default setting) dalam huruf ini. 
WWWWWWWW iiiiiiii pppppppp (lebar ketiga huruf sama).

Persoalannya adalah kapan kedua jenis fon tersebut dipakai? Huruf proporsional 
umumnya digunakan untuk dokumen resmi atau formal seperti buku, pedoman prakti-
kum, makalah, dan karya ilmiah atau profesional lainnya. Huruf nonproporsional 
(khususnya Courier) dapat digunakan dalam surat-menyurat pribadi untuk memberi sen-
tuhan klasik, nostalgik, dan personal.

Dari designa huruf itu sendiri, jenis huruf digolongkan mejadi jenis serif (berekor) 
dan sans serif (tanpa ekor atau polos). Fon Times New Roman adalah fon serif sedangkan 
fon Arial adalah fon sans serif. Secara tipografis, fon serif dirancang untuk badan tulisan 
sedangkan fon sans serif untuk judul atau subjudul. Fon serif dirancang agar susunan 
huruf yang membentuk kata menyatu dan menjadi suatu simbol atau gambar bukan 
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deretan huruf sehingga memungkinkan pembacaan cepat (speed reading). Hal ini 
diperkuat dengan fitur penyendian (kerning) yang merupakan opsi dalam pengolah kata. 
Apa yang dimaksud dengan penyedian diilustrasi di bawah ini. 

Bila fon sans serif digunakan untuk badan tulisan, keterbacaan akan berkurang dan 
mata akan menjadi cepat lelah karena dalam pemindaian kalimat mata harus menyatu-
kan huruf menjadi kata. Untuk judul yang hanya terdiri atas beberapa kata, fon sans serif 
tidak menimbulkan masalah dan justru menampilkan wajah yang estetis.

Dari sudut watak, fon digolongkan menjadi fon serius, santai (fun) atau dekoratif, dan 
karakter khusus. Fon serius digunakan untuk keperluan formal dan resmi (official) 
seperti korespondensi busines, dokumen pemerintah, kontrak, ijazah atau diploma, buku 
ajar, laporan keuangan, dan makalah ilmiah. Yang termasuk dalam fon serius antara lain 
adalah Times New Roman, Arial, Garamond, Zapf Elliptical, dan Century Schoolbook. 
Makalah ini ditulis dengan fon Century Schoolbook dari Bitstream.

Fon santai digunakan untuk keperluan informal dan bercanda seperti undangan 
pesta, selebaran (flyer), dekorasi panggung, iklan, sampul majalah hiburan, nama artikel 
hiburan, dan judul film. Yang termasuk dalam fon santai atau dekoratif antara lain adalah 
Impact, Rockwell, Comic Sans MS, Avant Garde, dan ITC Bookman.

Karakter khusus digunakan untuk berbagai keperluan tipografis dan keperluan 
khusus lainnya. Termasuk dalam fon ini adalah Symbol, Webdings, Dingbat, dan 
Wingdings.

Spacing 
Penspasian adalah pemberian ruang atau spasi antara huruf, kata, kalimat, paragraf, dan 
objek lain dalam suatu halaman cetakan. Tombol spasi (space bar) merupakan alat untuk 
memberi jarak antakata dan antarkalimat. Dengan teknologi komputer, jarak antarkata 
atau antarkalimat cukup satu spasi tidak perlu dua seperti pada mesin ketik. Demikian 
juga, jarak antara tanda baca dan kata berikutnya adalah cukup satu spasi. Selain untuk 
keperluan ini, tombol spasi hendaknya tidak digunakan untuk meluruskan secara vertikal 
huruf atau karakter lain. Gunakan fitur pengolah kata untuk keperluan ini.

Jarak atau spasi baris (line-space), yang sering keliru disebut spasi saja, sudah auto-
matis diatur melalui fitur pengolah kata dan jarak ini bergantung pada ukuran fon. Yang 
disebut jarak baris satu adalah jarak selebar ukuran fon ditambah lead sebesar dua titik 
(point). Jadi, untuk ukuran fon 10 titik, jarak baris satu adalah 12 titik. Untuk fon 11 
titik, jarak baris satu adalah 13 titik, dan seterusnya. Jarak baris dua tentunya adalah dua 
kali jarak baris satu. 

Tombol [Enter] digunakan untuk ganti paragraf tetapi tidak untuk memberi jarak 
antarparagraf apalagi antarbaris. Jarak antarparagraf harus diatur melalui fitur pengolah 
kata dengan menciptakan apa yang disebut gaya atau tampilan paragraf (paragraph style) 
yang dibahas berikut ini. 

Paragraph style
Dari aspek tipografis dan pengolah kata, paragraf adalah apapun yang ditulis di antara 
[Enter]. Judul atau subjudul merupakan paragraf dari sudut pandang pengolah kata. 

Tanpa penyendian: We To

Dengan penyendian: We To

difficult

difficult
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Sekali lagi, jangan sekali-kali menggunakan [Enter] atau [Space Bar] untuk menata 
wajah. Gunakan fitur gaya atau tampilan paragraf dalam pengolah kata. Dalam pengolah 
kata Word, fitur ini tersedia dalam menu Format>Style and Formatting. Contoh dan cara 
menggunakan menu ini akan ditunjukkan dalam presentasi.

Rancangan berbagai gaya paragraf dalam satu dokumen untuk tujuan penulisan ter-
tentu (misalnya buku, makalah, atau soal ujian) disebut sablon gaya (style sheet atau style 
template). Dari stelan pabrik, Word telah dilengkapi dengan beberapa gaya paragraf yaitu 
Normal, Heading 1, dan Heading 2. Cobalah fitur ini! Tentu saja untuk suatu dokumen 
yang kompleks, gaya paragraf yang tersedia ini tidak mencukupi bahkan mungkin tidak 
cocok dengan kebutuhan penulis. Penulis harus menciptakan sendiri sablon gaya yang 
sesuai dengan kebutuhan dan selera atau rasa estetisnya.

Text alignment
Pada umumnya, program pengolah kata (seperti Word) distel dari pabrik dengan tampilan 
rata-kanan (fully-justified) dan biasanya fitur pemenggalan sendiri (auto-hyphenation) 
juga dimatikan sehingga tidak ada kata yang terpenggal dengan tanda penggal (hyphen) di  
baris paling kanan suatu tulisan. Tidak berarti bahwa tulisan harus ditulis rata kanan 
dan pemenggalan kata tidak dimungkinkan. Bandingkan beberapa tampilan di bawah ini.

Tulisan yang ditampilkan rata kanan dimaksudkan untuk membawa kesan formal, 
resmi, kaku, objektif, interpersonal, dan serius. Oleh karena itu, tampilan ini banyak 
digunakan untuk buku atau jurnal ilmiah. Sementara itu, tulisan tidak rata kanan (rag-
ged right) dimaksudkan untuk membewa pesan informal, relaks (santai), personal, akrab, 
dan emosional sehingga banyak digunakan untuk korespondensi personal, manual 
produk, majalah hiburan, dan surat pribadi.

Secara tipografis, pemaksaan rata kanan (dikombinasi dengan tanpa pemenggalan) 
menimbulkan masalah keterbacaan atau kenyamanan membaca. Keterbacaan terganggu 
bila jarak antarkata menjadi tidak merata. Mata harus membaca dengan melompat dari 
satu kata ke kata lain secara bervariasi sehingga menimbulkan kelelahan khususnya 

Untuk lebih meningkatkan
keterbacaan suatu karya
ilmiah, aspek tipografis
harus diperhatikan dalam
penulisan. Aspek tipografis
memanfaatkan   elemen-
elemen tipografis yang
disediakan oleh teknologi
komputer. Dalam
menggunakan komputer
untuk menulis (word
processor),               harus
ditinggalkan jauh-jauh
kebiasaan-kebiasaan yang
melekat pada mesin ketik.

Untuk lebih meningkatkan 
keterbacaan suatu karya 
ilmiah, aspek tipografis 
harus diperhatikan dalam 
penulisan. Aspek tipografis 
memanfaatkan elemen-ele-
men tipografis yang disedi-
akan oleh teknologi 
komputer. Dalam menggu-
nakan komputer untuk 
menulis (word processor), 
harus ditinggalkan jauh-
jauh kebiasaan-kebiasaan 
yang melekat pada mesin 
ketik.

Rata kanan tanpa
pemenggalan

Takrata kanan dengan
pemenggalan

Untuk lebih meningkatkan
keterbacaan suatu karya il-
miah, aspek tipografis harus
diperhatikan dalam penulis-
an. Aspek tipografis me-
manfaatkan   elemen-ele-
men tipografis yang  disedi-
akan oleh teknologi kom-
puter. Dalam menggunakan
komputer untuk menulis
(word processor), harus di-
tinggalkan jauh-jauh kebi-
asaan-kebiasaan yang mele-
kat pada mesin ketik.

Rata kanan dengan
pemenggalan (automatik)

*

*

* tidak disarankan
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untuk tulisan yang cukup panjang. Bila dipaksa rata kanan, kenyamanan membaca akan 
terpengaruh terutama pada tulisan dengan kolum sempit atau pendek. Untuk kolum yang 
cukup lebar, perbedaan jarak antarkata tidak begitu kelihatan tetapi secara tipografis 
tetap tidak nyaman dibaca bila terjadi apa yang disebut sungai (river) dalam badan suatu 
tulisan terutama bila jarak baris adalah satu. Bila kita mempunyai cetakan dokumen 
dengan jarak baris satu dan rata kanan tanpa pemenggalan, putarlah dokumen itu 180° 
dan sejajarkan dengan sumbu mata kemudian lihatlah apakah terdapat sungai-sungai 
putih yang cukup kentara. Bila hal itu terjadi, cara pemecahannya adalah pemenggalan 
atau penampilan takrata kanan atau keduanya.

Emphasis (attributes)
Secara umum, badan tulisan hendaknya menggunakan atribut biasa (plain) tentu saja 
dengan fon serif. Penggunaan huruf tebal semua, huruf besar semua, atau huruf miring 
semua adalah berlebihan (overkill) dan bahkan mengurangi keterbacaan. Huruf miring 
dan tebal hendaknya digunakan untuk penekanan bila memang benar-benar diperlukan. 
Karena kita tidak lagi menggunakan mesin ketik, gunakan penekanan dengan huruf 
miring bukan garis bawah. Garis bawah menimbulkan gangguan pembacaan (distracting). 

Typographic characters
Teknologi komputer dan pengolah kata menyediakan karakter tipografis yang tidak 
mungkin diperoleh dengan mesin ketik. Word, misalnya, menyediakan karakter tersebut 
dengan Symbols atau Special Characters melalui perintah Insert>Symbols. Jangan meng-
gunakan warisan mesin ketik untuk menampilkan tanda baca atau simbol yang telah 
tersedia dalam pengolah kata. Tabel di halaman berikut menyajikan beberapa contoh 
warisan mesin ketik dan cara menggantinya dengan karakter tipografis untuk membeda-
kan antara mengetik (typing) dan menata wajah (type setting).

Pentingnya Tanda Baca
Tanda baca dan pengejaan sebenarnya juga merupakan bagian penting dari aspek 
tipografi walaupun hal tersebut sering dibahas dalam kaitannya dengan keterampilan 
menulis (writing skills). Griffin (1997) menggabungkan aspek tipografi dengan aspek 
menulis dalam busines. Di Amerika, salah eja dianggap sebagai kesalahan yang tercela 
dan memalukan sehingga kesalahan tersebut sering mengurangi skor pekerjaan tulis pel-
ajar/mahasiswa. Hal tersebut terjadi karena penggunaan tanda baca dan pemilihan ejaan 
didasarkan atas pedoman yang baku dan bukan selera.  Di Indonesia, hal ini tampaknya 
belum menjadi perhatian kalangan profesi maupun akademik padahal sudah ada pedoman 
berupa Ejaan Bahasa Indonesia Yang Disempurnakan (EYD) dan Pedoman Umum Pem-
bentukan Istilah (PUPI) dalam Depdikbud (1988). Suadi (1998) menunjukkan bahwa 
laporan keuangan auditan yang dihasilkan kantor akuntan Indonesia yang berafiliasi 
dengan kantor akuntan asing mengandung kesalahan gramatis dan tanda baca.

Begitu pentingnya tanda baca dalam tulisan-tulisan berbahasa Inggris sehingga 
buku-buku yang menjadi teks untuk pelajaran komunikasi dan keterampilan menulis 
selalu membahas tanda baca (punctuation) dan pengejaan (spelling) dalam salah satu bab-
nya. Telah disebut di atas, Gartside (1989) mencurahkan lima bab masing-masing untuk: 
grammatical background, sentence building, common errors in business writing, punctua-
tion, dan spelling. Penggunaan tanda baca yang benar dijelaskan dalam EYD. Sabin (1985) 
memberi petunjuk yang komprehensif tentang tanda baca untuk penulisan dalam bahasa 
Inggris. Tanda baca meningkatkan keterbacaan suatu tulisan. Penggunaan tanda baca
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yang tidak tepat atau tidak digunakannya tanda baca dapat mengaburkan arti. Secara 
tipografis, prinsip penggunaan tanda baca adalah:

• Melekat pada kata yang diberi tanda baca; tidak ada tanda baca menggantung.
• Diberi satu spasi saja sesudah tanda baca (tidak perlu dua spasi).
• Tidak ada tanda baca rangkap; kecuali untuk tujuan khusus misalnya pemi-

sahan nama dalam daftar pustaka.

 Tabel 1 

Pada jaman mesin ketik, sesudah titik dianjurkan untuk memberi dua spasi agar 
jarak antarkalimat menjadi jelas karena mesin ketik menggunakan huruf nonpropor-
sional. Hal penting yang erat kaitanya dengan aspek tipografis adalah penulisan simbol 
rupiah (Rp). Hal ini perlu diperhatikan khususnya untuk program studi ekonomika dan 
busines yang banyak membahas angka-angka rupiah. Hal yang perlu diperhatikan dalam 
penulisan simbol rupiah adalah (lihat EYD butir G.3 dan J.2):

• Rp adalah simbol bukan singkatan sehingga penulisannya tidak pakai titik.
• Huruf R ditulis kapital dan huruf p ditulis biasa.
• Dalam badan kalimat, sesudah simbol Rp tidak diperlukan spasi
• Dalam rincian ke bawah, Rp digunakan untuk angka rupiah paling atas dan 

sesudah tanda jumlah; simbol Rp secara vertikal lurus dengan Rp yang melekat 
pada angka terpanjang.

• Bila angka rupiah bulat, angka sen (00) tidak perlu ditulis kecuali dalam doku-
men resmi seperti kontrak.

• Penulisan koma dan tanda hubung (,-) sebagai pengganti sen (00) sangat tidak 
dianjurkan karena tanda tersebut mengganggu kelancaran membaca (menjadi 
tanda baca).

Karakter 
Tipografis Warisan Mesin Ketik Teknologi Komputer

Bold

Emphasis

em dash

en dash

minus sign

plus minus sign

vulgar fraction

bullet

JUDUL BAB

Penekanan

Pemerintah---non-laba

2005-2006

-43,215

plus-minus 235

1 1/2

1 3/4

- Mobil

- Sepeda motor

Judul Bab

Penekanan

Pemerintah—non-laba

2005–2006

–43,215

± 235

1½

1¾

• Mobil

• Sepeda motor
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Contoh penulisan simbol rupiah secara tipografis: 

Arti penting aspek tipografis tanda baca, simbol rupiah, dan kaidah penulisan lain 
dicontohkan dalam suatu paragraf di bawah ini. Contoh 1 mengandung berbagai kesa-
lahan tanda baca dan tipografis sedangkan Contoh 2 adalah perbaikannya dengan tetap 
mempertahankan rata kanan sehingga jarak antarkata masih terlihat tidak sama. Karena 
lebar kolum pendek, untuk mengatasi jarak antarkata yang tidak merata, perbaikan 
masih dapat dilakukan dengan membuat tulisan tidak rata kanan seperti Contoh 3.

Penulisan yang menyalahi aspek tipografis Penulisan tipografis

Rp  5.000
Rp.  5.000
RP.  5.000,00
Rp.  5.000,-
Rp.  5.000,--

Rp.        5.000
Rp.  125.000
Rp.      17.500
Rp. 3.450.000
Rp.    210.000
Rp. 3.797.500

Rp.        5.000
„     125.000
„         17.500
„    3.450.000
„       210.000
Rp. 3.797.500

Rp5.000
Rp5.000,00

Rp        5.000
125.000

17.500
3.450.000

210.000
Rp3.797.500

PT. ABC menjual sahamnya dengan niliai nominal Rp.
10.000 per saham. Modal dasar dalam penerbitan saham
tersebut adalah RP. 50.000.000,--. Dengan demikian,
telah direncanakan untuk diterbitkan sebanyak 5.000 (
lima ribu ) saham. Pemegang saham / pemilik lama
memperoleh hak untuk membeli dahulu. Direktor
keuangan mengatakan : “Ini merupakan penawaran yang
menarik”. Benarkah hal ini?.

PT ABC menjual sahamnya dengan niliai nominal
Rp10.000 per saham. Modal dasar dalam penerbitan
saham tersebut adalah Rp50.000.000. Dengan demikian,
telah direncanakan untuk diterbitkan sebanyak 5.000
(lima ribu) saham. Pemegang saham/pemilik lama
memperoleh hak untuk membeli dahulu. Direktor
keuangan mengatakan: “Ini merupakan penawaran yang
menarik.” Benarkah hal ini?

Contoh 1

Contoh 2

PT ABC menjual sahamnya dengan niliai nominal 
Rp10.000 per saham. Modal dasar dalam penerbitan 
saham tersebut adalah Rp50.000.000. Dengan demikian, 
telah direncanakan untuk diterbitkan sebanyak 5.000 
(lima ribu) saham. Pemegang saham/pemilik lama mem-
peroleh hak untuk membeli dahulu. Direktor keuangan 
mengatakan: “Ini merupakan penawaran yang menarik.” 
Benarkah hal ini?

Contoh 3
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Simpulan
Untuk lebih meningkatkan keterbacaan suatu karya ilmiah termasuk buku ajar, aspek 
tipografis harus diperhatikan dalam penulisan. Aspek tipografis memanfaatkan elemen-
elemen tipografis yang disediakan oleh teknologi komputer. Dalam menggunakan kom-
puter untuk menulis (word processor), harus ditinggalkan jauh-jauh kebiasaan-kebiasaan 
yang melekat pada mesin ketik. Tanda baca dan pengejaan merupakan bagian penting 
dari aspek tipografis. Suatu institusi yang mengeluarkan pedoman penulisan karya ilmiah 
(skripsi, tesis, dan disertasi) hendaknya memasukkan pula aspek tipografis yang harus 
ditaati. Pedoman-pedoman tipografis yang bermanfaat bagi penulis dokumen cetakan dan 
beberapa contoh kesalahan-kesalahan tipografis dilampirkan di akhir tulisan ini sebagai 
bahan diskusi. 
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Di bawah ini adalah contoh tulisan mahasiswa MM untuk suatu tugas dalam mata kuliah 
Etika Busines. Contoh ini disalin apa adanya persis seperti aslinya baik isi, fon, ataupun 
formatnya. Perhatikan beberapa kesalahan tipografis lain yang terjadi..

THE HEALTH BUSINESS

Christy deMeurers adalah salah satu anggota Health Net ( sebuah organisasi

asuransi kesehatan )  yang  menderita  penyakit   kanker.    Bersasarkan

rekomendasi Dr. Gupta bahwa penyakit kanker deMeurers harus dilakukan

pencangkokan ( transplatasi ) dengan biaya sebesar $ 100.000. Sementara

rekomendasi Dr. Millen bahwa penyakit tersebut dapat dicoba dengan

melakukan pengobatan.

Pengelolaan asuransi dari Health Net adalah sebuah usaha bisnis yang juga

tidak meninggalkan unsur sosial. Dari sisi etika moral Health Maintenance

Organization ( HMO ) memberi insentip  bagi  para  pegawainya untuk

dapat mencapai effisiensi biaya dalam medical care, serta dapat memberikan

motivasi untuk dapat bekerja sama dengan baik.

Kebijakan HMO dalam melayani Christy deMeurers secara etika menyalahi

karena tidak dapat menanggung biasa operasi anggotanya dengan alasan

bahwa operasi tranplatasi ini sebagai investigasi atau sebuah eksperimen,

yang secara implisit tidak tercantum dalam kontrak asuransi yang dijamin.

Juga HMO menggunakan sistem capitation dalam melayani pada anggotanya

sehinga menjadi usaha bisnis yang cukup menguntungkan.

Tanggung jawab secara moral dari HMO sebaiknya dapat memberikan suatu

bantuan kepada anggotanya sesuai dengan haknya berupa bantuan biaya

operasi yang besarnya sesuai dengan standar biaya yang disepakati pada

saat terjadi klaim dari seorang anggota.

Pada akhirnya deMeurers melakukan operasi dengan biaya sendiri , dalam hal

ini dilihat dari sisi etika moral tindakan ini merupakan hak pribadi untuk

memilih yang terbaik bagi dirinya.

Lampiran 1
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Di bawah ini adalah contoh lain tulisan mahasiswa MM untuk suatu tugas dalam mata 
kuliah Etika Busines. Contoh ini disalin apa adanya persis seperti aslinya baik isi, fon, 
ataupun formatnya. Perhatikan beberapa kesalahan tipografis lain yang terjadi. 

Phillip Morris’s Troubles

     A.  PENDAHULUAN

Sebagai sebuah perusahaan yang bergerak di bidang tembakau, makanan, serta

beer; Phillip Morris mempunyai performa keuangan yang sangat baik. Data-data berikut

mendukung hal tersebut : keuntungan perusahaan di tahun 1995 meningkat 15 % dari

tahun sebelumnya. Profit di bidang tembakau meningkat 16 %, di segmen makanan 7 %

dan segmen beer mencapai kenaikan 8 %.

Sayangnya di sisi lain, Phillip Morris juga mengalami kesulitan yang serius

menyangkut hubungannya dengan para konsumen serta kalangan pemeintahan. Kesulitan

perusahaan berupa adanya sekitar 125 perkara hokum yang tersisa menunggu

penyelesaian perkara. Perkara dimaksud adalah adanya tuntutan dari pihak luar mengenai

berbagai dampak yang timbul sebagai akibat konsumsi masyarakat akan rokok dan beer.

Rokok ditengarai sebagai penyebab utama kanker paru-paru sedangkan beer menjadikan

konsumennya tidak dapat menjalankan aktivitas pekerjaannya secara normal. Hal itulah

yang telah menyebabkan Phillip Morris ---juga perusahaan sejenis, telah dicap sebagai

penyimpan “uang kotor”.

Di tahun 1995, dengan pendapatan $ US 53 Milyar, profit mencapai US $ 5,45

Milyar didukung dengan 151.000 karyawan telah menjadikan Phillip Morris menjadi

perusahaan rokok dan makanan terbesar di USA. Yakni setelah mengakuisisi berbagai

perusahaan di USAyang dilakukannya sejak tahun 1969 hingga sekarang. Di antara

perusaaan yang diakuisisinya antara lain Miller Browing Company dan General Food. Di

tahun 1993 bahkan mengakuisisi pula perusahaan permen Frei Marabou. Sehingga

menempatkan Phillip Morris sebagai pemimpin pasar melali merek-merek rokok terkenal

kdkdkdkdkdkdkdkdkkdk.

Lampiran 2
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Membuat Daftar Isi 

Tombol [Space Bar] hendaknya tidak digunakan untuk meluruskan karakter, angka, 
atau objek lain secara vertikal dengan mengandalkan mata. Hal ini biasanya terjadi pada 
waktu pembuatan daftar isi yang menggunakan penuntun titik (dot leader). Berikut ini 
adalah contoh daftar isi yang sering dijumpai dalam skripsi atau laporan penelitian.

Pendahuluan............................................................       1
Latar Belakang Masalah..........................................       2
Tinjauan Pustaka.....................................................      12
Pengembangan Hipotesis........................................       20
Metoda Penelitian...................................................      40
Simpulan.................................................................    125

Penuntun titik di sebelah kanan dan juga angka halaman tidak lurus vertikal karena 
pelurusan dilakukan secara visual bukan dengan menggunakan gaya paragraf. Dengan 
gaya paragraf, daftar isi di atas akan tercetak seperti di bawah ini.

Pendahuluan ......................................................... 1
Latar Belakang Masalah....................................... 2
Tinjauan Pustaka .................................................. 12
Pengembangan Hipotesis ..................................... 20
Metoda Penelitian ................................................ 40
Simpulan .............................................................. 125

Cara membuat gaya paragraf untuk daftar isi:

1. Letakkan kursor di awal baris, sebaiknya pada gaya Normal
2. Klik Format>Styles and Formatting>New Style...
3. Isi kotak Name: dengan nama gaya, misalnya Daftar Isi
4. Klik Format>Tabs..
5. Isi kotak Tab Stop Position: dengan misalnya 1
6. Klik Left untuk Alignment kemudian klik Set
7. Isi lagi kotak Tab Stop Position:  dengan misalnya 5
8. Klik Right untuk Alignment kemudian klik 2 untuk Leader dan klik Set
9. Isi lagi kotak Tab Stop Position:  dengan misalnya 5.5

10. Klik Right untuk  Alignment kemudian klik 1 (None) untuk Leader dan klik 
Set

11. Klik OK, lalu OK lagi
12. Gaya paragraf telah tercipta dan “Daftar Isi” akan tampak dalam menu 

gaya paragraf !

Lampiran 3
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Di bawah ini adalah salah satu contoh materi yang dimuat dalam brosur seminar sehari 
bertema Desktop Publishing Design yang diselenggarakan oleh Mavis & Moore. Materi 
yang dibahas adalah masalah rata kanan dan takrata kanan.

Copyright 1997 / Mavis & Moore / 1706 Cambridge Road / Ann Arbor, Michigan 48104-5210 / All rights reserved.

Clip-and-save desktop publishing quick-reference guide

Which to use: justified vs. ragged right . . .
by KRISTINE MOORE

 HENEVER YOU DESIGN a 
 publication, a key
 decision is whether to

set the text with justified or  
ragged right type.

Justified type has uneven word 
spacing and even line widths. 
Ragged right type has even word 
spacing and uneven line widths.

Justified type almost always is 
hyphenated. (Hyphenation occurs 
when a hyphen is used to break a 
word between two lines.) Justified 
type without hyphenation suffers 
from excessive word spacing.

Ragged right type may or may 
not be hyphenated. Even when it is 
hyphenated, it is usually has fewer 
divided words than justified type.

Here are five factors to consider 
when choosing which style to use.

1. READABILITY. According to 
one study, ragged right type is eas-
ier to read for about 7 out of 10 
people. Other studies find little  
difference in readability between 
justified and ragged right type.

2. SUITABILITY. Which style 
will create the most suitable image

Kristine Moore is the creator and  
leader of the “Desktop Publishing 
Design” seminar as well as a partner  
in Mavis & Moore.

Copy set justified:

Justified type has even margins
on both sides. To create lines of the
same width, the space between
words varies from line to line.
Ragged right type has an even left
margin and an uneven right mar-
gin. Although the line width var-
ies, the space between words re-
mains the same.

Copy set ragged right:

Justified type has even margins 
on both sides. To create lines of 
the same width, the space 
between words varies from line 
to line. Ragged right type has an 
even left margin and an uneven 
right margin. Although the line 
width varies, the space between 
words remains the same.

for your publication?  Justified 
type creates a quiet, traditional, 
formal look. Ragged right type  
creates a more active, more con-
temporary, more informal look.

3. PRODUCIBILITY. All word 
processing and page layout       
software can produce both justi-
fied and ragged right type.

Today’s software also can 
hyphenate automatically. (Some  
do a better job than others.)

When you use automatic 
hyphenation you’ll need to take 
time to check for bad word breaks 
(a “therapist” turned into “the-
rapist,” for example). 

You’ll also need to look for ex-
cessive hyphenation (several lines 
in a row that end with hyphens).

If your time is limited, you may 
want to avoid those problems by 
using ragged right type without 
hyphenation. (Avoid using  justi-
fied type without hyphenation.)

4. LINE WIDTH. If your line 
width is very short, ragged right 
usually works best. When type is 
justified is a short line, gaping 
holes often appear between words.

5. SPACE. How much space do 
you have? On average, justified 
copy usually fills about 3 percent 
less space than the same copy set 
ragged right. "

Point-Counterpoint

“One of the things that bugs  
me now is the huge amount    
of type set ragged right.       
That’s an irritation to the   
eye. When we have to do a    
job over and over again, the 
only way we can do is       
rhythmically. Justified type 
makes that process easier.   
The eye does not have to 
adjust to a different sweep     
on each line. Now we have  
people who think ragged   
right type is the greatest 
invention since the zipper.”

EDMUND C. ARNOLD
Author and newspaper
design consultant

"

“Ragged-right reads better.      
In setting justified copy, the 
typesetter (whether a           
person or a programmed 
machine) often has to spread 
out the space between      
words to make the lines     
come out the same length.  
The resulting uneven         
spacing affects the visual 
rhythm of each line and dis-
turbs reading: it makes the  
eye stumble, as it tries to   
compensate for these imbal-
ances. That is tiring work. 
Ragged-right overcomes the 
problem by simply doing   
away with it. Type appears the   
way it is supposed to:           
naturally spaced. It looks    
and reads best that way.”

JAN V. WHITE
Author and publications
design consultant

W 

Lampiran 4
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Di bawah ini adalah pedoman tipografis yang diberikan oleh Susan Plumley dalam buku-
nya, Look Your Best with Ami Pro (Carmel IN: QUE Corp., 1992), hlm. 89-90.

Understanding Design Flaws
Readability is among the primary reason for making good design and type 
choices. If your work is not easy to read of the design is distracting, you 
are wasting your time producing the document. The most important 
thing to remember is the comfort and interest of the reader. The follow-
ing list describes the choices to avoid when setting type:

• Don’t use too many typefaces in one document; remember the 
two-font rule.

• Don’t use all uppercase with Script and Text fonts.

• Don’t use bold or italic as body of text.

• Don’t use all uppercase for more than three or four words.

• Don’t use place two spaces after a period.

• Don’t use too many type styles or sizes in a document. Too much 
variation confuses and distract the reader.

• Don’t use type larger than 12 points or smaller than 9 points for 
body text.

• Don’t use more than two hyphens is a row. Watch the letter and 
word spacing. If you have too many hyphens, try adjusting the  
column width.

• Don’t use plain hyphens; use discretionary hyphens.

• Don’t use inconsistent line and paragraphs spacing. The reader 
should be able to scan effortlessly across the page.

• Don’t apply more than one alignment to body text in a document. 
Match the alignments of body, heads, and subheads.

• Don’t make captions as large as a body text, but don’t make them 
too small to read. As a general rule, make the caption one or two 
points smaller than the body, in bold or italic.

• Don’t indent a paragraph too much. Use the line length as a guide. 
A 2 1/2-inch line length. for example, requires no more than a 1/4-
inch indent. A 4-inch line length, however, may use up to a 1/2-
inch indent. Avoid using indents of less than 1/4 inch and more 
than 1/2-inch.

• Don’t indent the first sentence more than 1/4 inch. Always use a 
tab to indent, never spaces.

• Don’t use too many callouts, jumplines, bullets, bold, or italic.

• Don’t use different styles of bullets in the same document.

• Don’t work without a style sheet.

Lampiran 5
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Robin Williams, konsultan designa grafik dan tipografi, memberi pedoman tipografis yang 
merupakan ringkasan buku The PC Is Not A Typewriter (Berkeley, CA: Peachpit Press, 
1992), hlm. 87-88 seperti di bawah ini.

Guidelines
The following is a compendium of the guidelines established in this book. 
You might want to check them each time you complete a publication.

! Use only one space between sentences.

! Use real quotation marks.

! Check the punctuation used with quote 
marks.

! Use real apostrophes.

! Make sure the apostrophes are where 
they belong.

! Use en and em dashes where appropriate.

! Use the special characters whenever   
necessary, including super- and subscript.

! Spend the time to create nice fractions.

! If a correctly-spelled word needs an 
accent mark, use it.

! Don’t underline.

! Never use all caps in body of text; rarely 
use it in heads.

! Kern all headlines where necessary.

! Never use the space bar to align text.

! Use one-em first-line indent on all 
indented paragraphs.

! Use a decimal or right-aligned tab for the 
numbers in numbered paragraphs.

! Leave no widows or orphans.

! Never have more than two hyphenations 
in any paragraphs.

! Avoid too many hyphenations in any 
paragraph.

! On every line of text in the document, 
watch all line breaks carefully. Be sensi-
ble.

! Keep the line spacing consistent.

! Tighten up the leading in lines with all 
caps or with few ascenders and    
descenders.

! Adjust the spacing between paragraphs; 
rarely use a full line of space between 
paragraphs in body text.

! Either indent the first line of paragraphs 
or add extra space between them—not 
both.

! Never justify the text on a short line.

! Hang the punctuation off the aligned 
edge.

! Use serif type for body text unless you are 
going to compensate for the lower read-
ability of sans serif.

! Never combine two serif fonts on one 
page.

! Never combine more than two typefaces 
on one page (unless you’ve studied typo-
graphy). 

! So the gist is: if you’re are going to use 
more than one face, use one serif and one 
sans serif.

! Use italic and bold sparingly.

! Use proper punctuation with paren-
theses.

! Align the first baselines of juxtaposed  
columns.

! Encourage white space.

! Don’t crowd text inside a box—let it 
breath.

! Be consistent.

! Use some sort of bullet when listing 
items, not a hyphen.

! Avoid abbreviations.

! Use small caps for A.M. and P.M.; space 
once after the number, and use periods.

! Reduce the size of punctuation marks in 
headlines.

! Set the space before an italic word also in 
italic.

! Don’t be a wimp.

Lampiran 6
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